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Welcome to RBZip 11! 

RBZip is the zip archive utility to expand the possibilities of
archiving and extracting files for both R:BASE developers
and clients!
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1 Introduction

1.1 Introducing RBZip 11

RBZip is a Plugin that allows R:BASE users the ability to create, add to, and extract zip files from within
R:BASE. This powerful utility can be used from a command prompt or from the main dialog screen. A full
feature list is available for creating and extracting files, including the ability to create a self-extracting
executable. RBZip also includes the ability to archive files larger than 2GB.

RBZip supports the following parameters to create and add to existing zip files:

· Include path names 
· Include recursive directories 
· Support of splitting large files on separate disks 
· Permanently move files 
· Alter the date and time stamp of the files
· Encryption of file headers so only RBZip can open the zip file 
· Maintain separate file directories 
· Add password protection
· Add a comment 

With RBZip, extracting zip files is just as simple with these custom actions:

· Include full file path
· Restore the file date attributes
· Offers a "Overwrite" mode to either overwrite or skip existing file 
· List specific files, by name or file extension
· Can use recursive directories
· Can create directories

1.2 Copyrights

Information in this document, including URL and other Internet web site references, is subject to change
without notice. The example companies, individuals, products, organizations and events depicted herein
are completely fictitious. Any similarity to a company, individual, product, organization or event is
completely unintentional. R:BASE Technologies, Inc. shall not be liable for errors contained herein or for
incidental consequential damages in connection with the furnishing, performance, or use of this material.
This document contains proprietary information, which is protected by copyright. Complying with all
applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no
part of this document may be reproduced, stored in or introduced into a retrieval system, or transmitted
in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any
purpose, without the express written consent of R:BASE Technologies, Inc. We reserve the right to make
changes from time to time in the contents hereof without obligation to notify any person of such revision
or changes. We also reserve the right to change the specification without notice and may therefore not
coincide with the contents of this document. The manufacturer assumes no responsibilities with regard to
the performance or use of third party products.

Products that are referred to in this document may be either trademarks and/or registered trademarks of
the respective owners. The publisher and the author make no claim to these trademarks.

The software described in this document is furnished under a license agreement. The software may be
used or copied only in accordance with the terms of that agreement. Any unauthorized use or duplication
of the software is forbidden.

R:BASE Technologies, Inc. may have patents, patent applications, trademarks, copyrights, or other
intellectual property rights covering subject matter in this document. Except as expressly provided in any
written license agreement from R:BASE Technologies, Inc., the furnishing of this document does not give
you any license to these patents, trademarks, copyrights, or other intellectual property.

Trademarks
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R:BASE®, Oterro®, RBAdmin®, R:Scope®, R:Mail®, R:Charts®, R:Spell Checker®, R:Docs®, R:BASE
Editor®, R:BASE Plugin Power Pack®, R:Style®, RBZip®, R:Mail Editor®, R:BASE Dependency Viewer®,
R:Archive®, R:Chat®, R:PDF Form Filler®, R:FTPClient®, R:SFTPClient®, R:PDFWorks®, R:Magellan®,
R:WEB Reports®, R:WEB Gateway®, R:PDFMerge®, R:PDFSearch®, R:Documenter®, RBInstaller®,
RBUpdater®, R:AmazonS3®, R:GAP®, R:Mail Viewer®, R:Capture®, R:Synchronizer®, R:Biometric®,
R:CAD Viewer®, R:DXF®, R:Twain2PDF®, R:Scheduler®, R:Scribbler®, R:SmartSig®, R:OutLink®,
R:HASH®, R:JobTrack®, R:TimeTrack®, R:Manufacturing®, R:QBDataDirect®, R:QBSynchronizer®,
and R:QBDBExtractor®, and Pocket R:BASE® are trademarks or registered trademarks of R:BASE
Technologies, Inc. All Rights Reserved. All other brand, product names, company names and logos are
trademarks or registered trademarks of their respective companies.

Windows, Windows 11-10, Windows Server 2025-2016, Azure Maps, Word, Excel, Access, SQL Server,
and Outlook are registered trademarks of Microsoft Corporation. OpenOffice is a registered trademark of
the Apache Software Foundation. 

Printed:  July  2025 in Murrysville, PA

First Edition

1.3 License

R:BASE TECHNOLOGIES, INC. LICENSE AGREEMENT

RBZip 11
Single Seat License

This is a legal agreement between you, the end user ("Licensee"), and R:BASE Technologies, Inc.
("RBTI"). Please read the terms and conditions of this License Agreement before using this software. By
you selecting "I accept the license agreement" and clicking "Next" during product installation means you
expressly accept the terms and conditions of this Agreement. If you do not accept the terms and
conditions of this Agreement, you must stop installing the Product and click "Cancel". Your money will be
refunded based upon proof of purchase, and in compliance with the return period described in the
LIMITED WARRANTY below. A violation of the License, brings damage both financially and to the
reputation of RBTI, and in the occurrence of either, both termination of the license agreement and civil
damages will be vigorously sought. Once you have clicked "I accept the license agreement", you are
entitled to use the Product under the following terms and conditions of this Agreement:

LICENSE
This RBTI License Agreement permits you to use one copy of the RBZip computer software with
associated utilities (the “Program”) and accompanying user documentation (the “Documentation”) on
any single computer. If you do not have a Site License or at least one 5 Seat Add-On License, this
program can only be installed on a single machine. However, you can open multiple sessions and be
connected to the same and/or other local or network databases on the same machine simultaneously.
(The 5 Seat Add-On License permits additional seats to access the Program, in 5 seat increments if each
is physically linked to a single file server and you have obtained a separate license for a Single Seat
version of the Program. 5 Seat Add-On Licenses must be licensed at the same Single Seat version). A
Program is “being used” on a computer when it is loaded into a temporary memory or installed on a hard
drive in the computer. However, a copy of the Program installed on a network server for the sole
purpose of distribution to other computers is not “being used”. Each seat having access to the Program
must have an appropriate license. If you anticipate that the number of seats with access to the Program
will exceed the number of seats for which you are licensed, you must take steps to ensure that the
appropriate licenses are obtained for each seat.

5 SEAT ADD-ON AND SITE LICENSES 
If a printed or other form of “hard-copy” License accompanied the copy of the Program you received
whose terms vary from this agreement, then the hard-copy License governs your use of the Program. 5
Seat Add-On and Site Licenses allow you to install the Program on the total number of machines for
which you are licensed only.

SATELLITE LICENSES
A Satellite License permits a Licensee to use one copy of the copy of the Program on any additional
single computer, for additional development to accompany an existing Single Seat License. The Satellite
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License must be licensed to the same user as the existing Single Seat License. Each seat having access
to the Program must have an appropriate license.

EVALUATION LICENSES
If you have purchased or received an Evaluation License for the Program, the Evaluation Licenses are
inherently Single Seat licenses and are governed by the same stipulations regarding the limitations of
how many machines the Program can be installed on. Evaluation products may have certain features
disabled and are not marketed to be a full version product. Lastly, Evaluation Licenses are non-
transferable and may contain an expiration date or lockout after a certain period of time.

COPYRIGHT AND RESTRICTIONS
RBTI retains full ownership rights in the Program and Documentation. You may make a single copy of the
Program; to be used solely for backup or archival purposes, or you may transfer the Program onto a
single hard disk provided you keep the original solely for backup or archival purposes. Such copies shall
be owned by RBTI. You may not copy any printed material or Documentation without prior permission.
You may not decompile, disassemble cross-compile, reverse engineer, or make or distribute any other
form of, or derivative work from, the Program. You may not obscure, alter or remove any RBTI
copyright, trademark or proprietary rights notices.

TRANSFER OF LICENSE
You may not lend, rent or lease the Program or Documentation or any copies to any person. A transfer
of license is only authorized through completion of the Consent to Assignment and Assumption of
Contract agreement from RBTI. Upon license transfer, you are permanently giving such person
possession of all copies of the Program and Documentation, are permanently giving up your right to use
the Program and Documentation, and the recipient agrees to the terms of this License Agreement. 

STEP UPS AND UPGRADE PURCHASES
As the Licensee, you are authorized to use the Program only if you are an authorized user of a qualifying
product as determined by RBTI. The new license agreement takes the place of the agreement of the
qualifying software you stepped up or upgraded from. After you upgrade, you may no longer use the
software from which you upgraded. When you install the upgrade, you must uninstall the copy of the
qualifying product.

TERM OF LICENSE
The licensing provided in this License Agreement is perpetual unless you violate any of its terms or
conditions, at which time the license will automatically terminate. Upon termination you must return all
copies of the Program and Documentation to RBTI or certify in writing to RBTI that all such copies have
been destroyed and uninstalled from each workstation and/or network server. RBTI reserves the right to,
at its expense and without prior notice, conduct periodic inspections for licensing compliancy. If licensee
is found to be in violation of current agreement, RBTI may commence a civil action seeking fines,
damages, attorney’s fees and injunctive relief and may also, in appropriate circumstances, seek criminal
prosecution.

ACTIVATION CODES
The Program requires activation using a unique code. If you purchase a Single Seat License with or
without 5 Seat Add-On Licenses, you agree to comply with the license activation and verification
procedure described in this section of the Agreement. The activation technology may prevent your use of
the Program if you do not follow the activation process described in this Agreement. 

Each activation code is tied to one Windows operating system computer. A dual-boot computer with
multiple operating systems cannot activate a Single Seat License on more than one operating system.
Any software utilities which alter how the Program is installed on a local drive are not supported. This
includes any utilities which alter, remove or transfer the location of the Program on the hard drive, or
any hard drive utilities which alter the physical properties of the local drive.

The Program activation can be completed automatically through an Internet connection or manually
through a provided email option. In doing so, the Program Registration Number and Computer ID must
be provided. License validation allows a number of activations based upon the number of licenses
purchased.

If a computer is no longer using the Program, through license transfer or hardware failure, the Activation
Key that was used on the computer must be submitted to R:BASE Technologies so the key may be
disabled, which will then free up that used activation. Once a key is reported as no longer in use and
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deactivated, it can no longer be used on that computer. Product deactivation can be performed
automatically from within R:BASE. To review the License Key and Activation Key product information,
select "Help" > "Product Activation" from the Menu Bar. 

Licenses for the Corporate VIP Licenses of the Program are not controlled by activation codes and can be
operated from computers that are not connected to the Internet.

SOFTWARE SUPPORT
The availability of software support services is subject to the End of Support (EOS) and End of Life (EOL)
product life cycle, and to an active Software Assurance Plan. Where applicable, licensees will be provided
with an option to upgrade to the current supported version of a software product.

LIMITED WARRANTY
RBTI warrants to you, as the initial user, the Program will perform substantially in accordance with the
Documentation, provided it is used in unaltered form with functioning equipment and operating systems
for which it was designed. RBTI will, at its option, with proof of payment within 30 days of the invoice
date and after the Program with Documentation has been deactivated and uninstalled, and software
installer, whether provided by download or other means, permanently deleted from all drives and
folders, issue a full refund. These are your sole remedies for any breach of warranty. No exceptions will
be made.

SERVICES PROVIDED WITH PURCHASE

1. 30-Day Limited Complimentary Technical Support 

LICENSEE RESPONSIBILITIES

· To help us expedite the process and provide high quality assistance, the licensee must
provide proof of purchase when calling. Proof of purchase is defined as the following:
registration number, purchase date, version and build number, and company or individual to
which product is registered.

· To have operating system, workstations, and local network installed and functional. RBTI will
NOT be responsible for resolving issues not pertaining to the Program.

· Our support staff deals with advanced issues, therefore the person contacting RBTI for
assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

· To have the database(s) being converted, safely backed-up before attempting conversion
process.  RBTI will NOT be held responsible for lost data or corruption as a result of advice
given.

R:BASE TECHNOLOGIES, INC.  RESPONSIBILITIES
· To provide quality assistance in a timely manner to aid Licensee in the installation of the

product within 30 days of the date of purchase.
· To provide a reasonable solution for any resolvable issue.  Not all issues are resolvable, and

therefore we will acknowledge the existence of known issues or “bugs” which we are
presently aware of, that have no reasonable work-around.

RBTI reserves the right to limit the amount of support time allotted to a maximum of 2 HOURS
during the 30-Day Complimentary Technical Support Period.  We also reserve the right to limit the
quantity of calls from a particular Licensee to 30 MINUTES in a single day.  Issues are dealt with
on a case-by-case basis, and are handled at the discretion of the support agent assigned to the
case. Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related
issues ONLY. Our support hours are from 10am. to 6pm. Eastern Time.

For assistance on your APPLICATIONS, DESIGN, or ADVANCED CONVERSION issues, we offer
Technical Support Plans of various types to meet your needs.  Please visit the SUPPORT area of
our website at www.rbase.com for details and pricing.

2. Fixes for Known Issues
RBTI will provide continued product fixes for known issues or “bugs” for 1 YEAR from the software
purchase date. After 1 year, users are urged to acquire the necessary Software Assurance Plan to
continue with product support and ongoing activations for reinstallations and license transfers.
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3. Enhancement Requests
RBTI will provide continued product enhancements for requested features for 1 YEAR from the
software purchase date. After 1 year, users are urged to acquire the necessary Software Assurance
Plan to continue with product support and ongoing activations for reinstallations and license transfers.

4. Periodic Activations
RBTI will provide periodic product activations of license transfers and/or reinstallations for 1 YEAR
from the R:BASE purchase date. Any activation requests that occur beyond the 1 Year purchase date
will require an active Software Assurance Plan.

NO OTHER WARRANTIES
Except as explicitly stated above, RBTI makes no express or implied warranties (including any warranties
of merchantability or fitness) with respect to the character, function, or capabilities of the program, the
documentation or their appropriateness for any user’s purposes. RBTI cannot customize product(s) to
meet specific needs in all cases. Examples of customization include, but are not limited to: special
character sets, foreign language adaptations, specific device drivers or other localization issues. Under
no circumstances will RBTI be held responsible for product functionality once alterations have been made
to accommodate individual needs.

DISCLAIMER OF WARRANTY
The Program and the accompanying files are sold "as is" and without warranties as to performance or
merchantability or any other warranties whether expressed or implied. Because of the various hardware
and software environments into which the Program may be put, No warranty of fitness for a particular
purpose is offered. Good data processing procedure dictates that any program be thoroughly tested with
non-critical data before relying on it. The user must assume the entire risk of using the Program. Any
liability of the seller will be limited exclusively to product replacement or refund of purchase price.

HIGH RISK ACTIVITIES
The Program is not fault-tolerant and is not designed, manufactured or intended for use or resale as on-
line control equipment in hazardous environments requiring fail-safe performance, such as in the
operation of nuclear facilities, air traffic control, aircraft navigation or communication systems, direct life
support machines, or weapons systems, in which the failure of the Program could lead directly to death,
personal injury, or severe physical or environmental damage ("High Risk Activities"). RBTI specifically
disclaims any expression or implied warranty of fitness for High Risk Activities. 

LIMITATIONS ON LIABILITIES
RBTI will not be responsible for any costs or damages associated with loss of the use of the Program or
any other resources, loss of business or profits, any loss of data, any third-party claims or costs of
substitute programs. In no event will RBTI be liable for any incidental, indirect, special, consequential or
punitive damages suffered by the user or any other person or entity, whether from the use of the
program or documentation, any failure thereof, or otherwise, even if RBTI or its dealers or agents are
aware of the possibility of such damages. In no event will RBTI aggregate liability to you or anyone else
exceed two times the license fee you paid for the program and documentation in this package. Because
some states do not allow the limitation or exclusion of implied warranties and liabilities for consequential
or incidental damages, the above limitations may not apply to you.

GENERAL
This License Agreement constitutes the full and complete agreement between parties. RBTI retains all
rights not specifically granted herein. RBTI shall not be deemed to have waived any of its rights
hereunder or under all copyright laws, trade secrecy laws or otherwise. This Agreement is intended as a
legally binding agreement which will be enforced to the full extent permitted under applicable law, in
whole or in part. If any one provision of this Agreement is declared invalid or unenforceable, all
remaining provisions shall never less remain in effect. The laws of the state of Pennsylvania shall govern
this Agreement. RBTI reserves the right to amend, alter, or revoke this agreement at any time. All
revisions to this license agreement are available for inspection upon request, supersede conditions in all
past agreements, and render prior license agreements void and unenforceable. Both parties named in
this license will only be bound to the terms of the most current revision of this agreement.

U.S. GOVERNMENT RESTRICTED RIGHTS
Use, duplication or disclosure by the Government, its agents or employees is subject to all restrictions
imposed by law, regulation or government directive, including but not limited to those restrictions set
forth in DFARS 252.227-7013 and 48CFR 52.227-19, as applicable.
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R:BASE Technologies, Inc.
https://www.rbase.com
rbaseinfo@rbase.com

Copyright 1982-2025 R:BASE Technologies, Inc. 
All Rights Reserved
Revised Monday, July 07, 2025

1.4 Complimentary Support

30 DAY LIMITED COMPLIMENTARY TECHNICAL SUPPORT

A. LICENSEE RESPONSIBILITIES.

1. To help us expedite the process and provide high quality assistance, the licensee must provide
proof of purchase. Proof of purchase is defined as the following: registration number, purchase
date, version and build number, and company or individual to which product is registered.

2. To have operating system, workstations, and local network installed and functional. R:BASE
Technologies will NOT be responsible for resolving issues not pertaining to the software product.

3. Our support staff deals with advanced issues, therefore the person contacting R:BASE Technologies
for assistance should be the system administrator or have other R:BASE/SQL experience and be
able to understand and implement the advice given.

4. To have the database, application, and command files being reviewed, safely backed-up before
attempting assistance. R:BASE Technologies will NOT be held responsible for lost data or corruption
as a result of advice given.

B. R:BASE TECHNOLOGIES, INC. RESPONSIBILITIES.

1. To provide quality assistance in a timely manner to aid in the installation of the product and
elementary conversion of database, application, and command files within 30 days of the date of
purchase.

2. To provide a reasonable solution for any solvable issue. Not all issues may be solved, and
therefore we will acknowledge the existence of known issues, or bugs, which we are presently
aware of, that have no reasonable work-around.

R:BASE Technologies reserves the right to limit the amount of support time allotted to a maximum of 2
HOURS during the 30-Day Complimentary Technical Support period. We also reserve the right to limit the
quantity of calls from a particular licensee to 30 MINUTES in a single day. Issues are dealt with on a
case-by-case basis, and are handled at the discretion of the support agent assigned to the case.
Complimentary Support is limited to INSTALLATION and ELEMENTARY CONVERSION related issues ONLY.
Our support hours are Monday through Friday, from 10:00 AM to 6:00 PM (EST).

For application, design, or advanced conversion assistance, R:BASE Technologies offers Technical
Support Plans of various types to meet your needs. Please visit the Support page at
https://www.rbase.com/support for details and pricing.

https://www.rbase.com/support
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2 Installation

2.1 System Requirements

The following system specifications are recommended for the optimal use of R:BASE and R:BASE-related
software. 

Workstation Hardware

· 2-Core 2GHz+ CPU
· 2 GB of available RAM (4 GB recommended)
· 2 GB of available hard disk space
· 1024x768 or higher resolution video adapter and display
· Standard mouse or compatible pointing device
· Standard keyboard

Server Hardware

· 2-Core 2GHz+ CPU
· 6 GB of available RAM (8 GB recommended)

Operating System

· Microsoft Windows 11 (Professional)
· Microsoft Windows 10 (Professional)
· Microsoft Windows Server 2025
· Microsoft Windows Server 2022
· Microsoft Windows Server 2019
· Microsoft Windows Server 2016

Network

· Ethernet infrastructure (Gigabyte recommended)
· Internet connection recommended, but not required, for license activation, software updates, and

support
· Anti-virus programs should exclude the R:BASE program, and any add-on product, executable and

database files

2.2 Things You Will Need

· License Key

Before launching the installer, it is recommended that you have your 32-character License Key readily
available. The License Key is provided in a document, with the email message, when the software was
originally purchased. If you have lost or misplaced your License Key, please contact our Support Staff
by email at support@rbase.com.

· Internet Access

The computer where the software will be launched should have access to the Internet for activation.
The Internet access is used to visit the R:BASE Technologies Web site to provide your required
Activation Key.

In instances where the software will be installed on a computer that is not connected to the Internet,
you must then contact R:BASE Technologies to provide information displayed on the computer screen.
Please contact our Product Activation Staff by email at activationkey@rbase.com. The Registration
Number must be provided. The Registration Number is displayed on the invoice/order slip, and within
the email, when the software was originally purchased.

mailto:support@rbase.com
mailto:activationkey@rbase.com


RBZip 11 Help14

Copyright © 1982-2025 R:BASE Technologies, Inc.

2.3 Software Installation

The installation of RBZip is fully automated, and does not require user intervention for the initial
configuration. 

Run the installer ".exe", provided by download, while physically sitting at the workstation to begin the
installation process, and read the installer screens for licensing and other information as the program
installs.

Installation Directory   

C:\RBTI\RBZip11

Files Installed

RBZip11.rbm 
RBZip11.chm 
RBZip11.pdf
RBZip11.ico
License.rtf
ReadMe.txt

Requirements:

Plugin
The RBZip 11 Plugin file (RBZip11.rbm) must be placed in the R:BASE 11 program directory (default:
C:\RBTI\RBG11) or the runtime/compiled application directory. 

2.4 Plugin Activation

R:BASE Plugins can be used to enhance, or extend R:BASE operations. Current R:BASE Plugins use the
.RBM file extension. 

To begin using any plugin product, the plugin must be registered for use. 

The license type for R:BASE and R:BASE plugin products must match. The license keys supplied with
Single Seat and 5 Seat plugin products will only be accepted within Single Seat and 5 Seat versions of
R:BASE, and are not accepted within R:Compiler for R:BASE or Runtime for R:BASE programs. The same
license structure is also in place for Runtime License Keys for plugin products, where the key will not be
accepted within Single Seat and 5 Seat Licenses R:BASE. 

2.4.1 R:BASE

To begin using a plugin product, you must register the software within R:BASE by selecting "Help" >
"Product Activation" from the main Menu Bar. In this window, select the "Add New" button where you can
enter or copy and paste the License Key you received with your product. 

Only "Per Seat" License Keys are valid for this entry screen. All "Runtime" License Keys must be
registered within R:Compiler for R:BASE or within Runtime for R:BASE separately.
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After entering the License Key, you will see a dialog to prompt for your activation method. The software
can be activated automatically over the Internet, or manually by retrieving an Activation Key from
R:BASE Technologies by email or over the phone. If you select "Later", you will be reminded each time
R:BASE starts to activate your copy.

When activating the software manually, you select the e-mail link to launch your email client and send a
pre-formatted message to R:BASE Technologies that will contain your License Key and the displayed
Computer ID. You will need to provide your R:BASE Registration Number and Computer ID.

At any time, you can review your product information by starting R:BASE, and from the Menu Bar
clicking on "Help" > "Product Activation". Your R:BASE Registration Number is displayed on the window.
You can also enter additional License Keys for R:BASE add-on products.
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Please be advised that if you are activating multiple workstations, it is highly recommended
that you keep records of the computer name, Computer ID and Activation Key for future
reference. Access to this information will prove convenient in the event of a hardware
failure or license transfer when uninstalling R:BASE. 

Please see: Uninstall/Reinstall

2.4.2 R:Compiler for R:BASE

Runtime License Key
Runtime license keys for an R:BASE Plugin must be stored within the compiled executable. A specific
Runtime License Key would be provided after your purchase of the Runtime software product. Adding a
Runtime License to your project can be done by selecting the "Add License" button, and pasting the
appropriate Runtime License Key into the displayed dialog window.

After a Runtime License is added as a resource, it  will be assigned a "Resource ID". This ID consists of
the word "License" and an incrementing value for the number of licenses added to the executable. 

Plugin File (.RBM)
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R:BASE Plugin files can be added and stored within the compiled executable or included within the
R:BASE application directory. The Runtime license key pertaining to the R:BASE Plugin must be stored in
the compiled executable.

Adding a Plugin to the list of resources can be performed by selecting the "Add Plugin" button on the Tool
Bar. You will be prompted to locate the appropriate Plugin file with the .RBM file extension. After a Plugin
file is added as a resource, it will be assigned a "Resource ID". This ID consists of the Plugin file name. 

2.4.3 Runtime for R:BASE

After R:BASE Plugins are acquired for Runtime for R:BASE applications, the Plugin file must be included
in the Runtime application folder, to be loaded when the Runtime application launches. 

To load the Plugin, the License Key must be included into the Runtime for R:BASE session by adding the
following PROPERTY command within the application startup file: 

   PROPERTY ADD_LICENSE ####-####-####-####-####-####-####-#### ' '
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3 Uninstall

If a computer is no longer using RBZip, through license transfer or hardware failure, the Activation Key
that was used on that computer must be submitted to R:BASE Technologies so we can then remove the
Activation Key from our log. We will disable the Key, which will then free up that used activation. Once a
key is reported to us as no longer in use and deactivated, it can no longer be used on that computer.

Product deactivation can be performed automatically from within R:BASE. To review your product
information select "Help" > "Product Activation" from the Menu Bar. Here, the License Key and Activation
Key for a selected product is available for review. 

If the License Key for your product is not readily available for the license transfer, select the "Copy
License Key" button to send your License Key to the clipboard. 

To deactivate a listed product, select it and press the "Deactivate" button. The below confirmation dialog
will appear. After selecting "Yes", the product will be removed from the list.

After completing the deactivation of the product, it can be successfully reinstalled and activated.
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4 RBZip Interface

The RBZip interface can be launched by selecting "Utilities" > "Plugins" > "RBZip Plugin 11" from the

R:BASE main Menu Bar, or by running the SHOW_DIALOG parameter using the PLUGIN command.  

PLUGIN RBZIP vResult|SHOW_DIALOG

4.1 Create a New File

When the RBZip GUI interface first launches, the screen will be empty. To begin creating a zip archive
file, choose the "Create" button.

The "New Archive" dialog will display a list of zip files and folders in the current directory. You need to
navigate to the folder, which contains files to archive. When you have navigated to the desired location,
enter the name of the new zip file you wish to create and select "Open".

The RBZip window will display your new zip file name in the window caption and the "Add" button will be
enabled with a green plus. Choose the "Add" button to add the desired files to your archive zip file. A
dialog will appear for you to add files.
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The "Selected Files" tab is displayed first within the window. Add individual files to the archive zip file by
selecting each file and choosing the "Add File" button. You can also select all the files as well as add the
entire directory. 

Additional archive options, such as archive type, action type, compression method, password protection,
span disk, keeping the directory structure, including any sub folders, and attributes are available by
selecting the "Options" tab.
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Complete the archive process by selecting OK. A progress window will be displayed as files are added to
the zip file. The RBZip window will display the contents of the zip archive file.

4.2 Add Files

To add files to an existing zip archive file, first launch RBZip and then locate and open the zip archive file
using the "Open" button. When the file is opened, the zip archive file contents will be displayed. 

Choose the "Add" button for the "Add Files" dialog to appear. Use the "Folders" panel to navigate to the
folder, which contains files to add to the zip archive. When you have navigated to the desired location,
add individual files to the archive zip file by selecting each file and choosing the "Add File" button. You
can also select all the files as well as add the entire directory. 
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Additional archive options, such as archive type, action type, compression method, password protection,
span disk, keeping the directory structure, including any sub folders, and attributes are available by
selecting the "Options" tab.
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Complete the archive process by selecting OK. A progress window will be displayed as files are added to
the zip file. Select the "Close" button to return to the RBZip main window. The RBZip window will display
the new contents of the zip archive file.

4.3 Delete Files

To delete files to an existing zip archive file, first launch RBZip and then locate and open the zip archive
file using the "Open" button. When the file is opened, the zip archive file contents will be displayed. 

To delete a file or files, they must be selected within the display window. More than one file can be
selected by lassoing a group of files next to one another or by holding down the [Ctrl] key and clicking
on other file if they are spanned apart.



RBZip 11 Help26

Copyright © 1982-2025 R:BASE Technologies, Inc.

Select the "Delete" button to delete the selected files. You will be prompted for a confirmation. 

After selecting "Yes", a progress window will be displayed confirming the files were deleted. Select the
"Close" button to return to the RBZip main window.

4.4 Extract Files

4.4.1 Extract All Files

To extract a file or files from an existing zip archive file, first launch RBZip and then locate and open the
zip archive file using the "Open" button. When the file is opened, the zip archive file contents will be
displayed. 

Choose the "Extract" button for the "Select Extract Folder" dialog to appear. Using the tree list in the
panel, you can navigate to the destination folder where the files will be extracted. 
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When you have navigated to the desired location, additional options are available to extract the files with
the full path and overwrite the existing files. You can also define the folder location yourself by typing the
path in the "Destination Folder" filed. The "Date Attribute" option allow you to alter the date for the
extracted file(s). 

Select OK to extract the files.

A progress window will be displayed confirming the files were extracted. Select the "Close" button to
return to the RBZip main window.

4.4.2 Extract Individual Files

To extract a file or files, they must be selected within the RBZip display window. More than one file can
be selected by lassoing a group of files next to one another or by holding down the [Ctrl] key and
clicking on other file if they are spanned apart. 

Choose the "Extract" button for the "Select Extract Folder" dialog to appear. Using the tree list in the
panel, you can navigate to the destination folder where the file(s) will be extracted. 

When you have navigated to the desired location, additional options are available to extract the files with
the full path and overwrite the existing files. You can also define the folder location yourself by typing the
path in the "Destination Folder" filed. The "Date Attribute" option allow you to alter the date for the
extracted file(s). 

Select OK to extract the files.
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A progress window will be displayed confirming the files were extracted. Select the "Close" button to
return to the RBZip main window.

4.5 Test

To test the files within a zip archive file, first launch RBZip and then locate and open the zip archive file
using the "Open" button. When the file is opened, the zip archive file contents will be displayed. 

Test the files by selecting the "Test" button. A progress window will be displayed confirming the files were
tested. 
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Select "Close" to return to the RBZip main window.

4.6 Comment

Add commenting to your archive file within the "Comment" button.
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4.7 Convert Zip Archive to Self-Extracting EXE

An Self-Extracting (SFX) archive is an archive, merged with an executable module, which is used to
extract files from the archive when executed. Thus, no external program is necessary to extract the
contents of an self-extracting archive, it is enough to execute it.  Self-Extracting archives are convenient,
when providing a user with an archive, but do not know, if they have the required archive software to
extract files from it. You may also use SFX archives to distribute software.

To convert a zip archive file to a self-extracting executable, first launch RBZip and then locate and open
the zip archive file using the "Open" button. When the file is opened, the zip archive file contents will be
displayed. Select the "Zip ->Exe" button for the "Make Self Extracting Archive" dialog will appear.

The "Default Overwrite Action" options control the default behavior of the extraction for files with the
same name. If a file with the same name is located in the specified folder location, the available options
are to ask the user, always overwrite, or skip the extraction of that file.

The available check boxes allow even more control over the self-extracting archive.

The "Allow User to avoid Running the Command Line" option can be specified for self-extracting archive
files that run a program and file after the extraction is complete. By enabling the user to interfere, a
check box is displayed before the extraction giving them the choice. Refer to Command line to Execute
after Extraction.

The "Allow User to Modify the File List to Be Extracted" option can be specified to allow the user to
remove files from the list that are to be extracted. When the self-extracting archive is first launched, all
the files are selected.



RBZip Interface 31

Copyright © 1982-2025 R:BASE Technologies, Inc.

The "Hide Overwrite Action Group Box at Run Time" option enables the removal of the overwrite action
options. When enabled,  the file extraction process will follow the "Default Overwrite Action", which was
specified when the self-extracting archive was created.

The "Create an AutoRun SFX" option will create a self-extracting archive file that will extract the archive
file contents with no user interaction. Once the self-extracting archive file is complete, the executable file
name must be renamed to begin with an exclamation mark "!".

The "Do Not Show the Success Message After File Extraction" option will disable the small pop up dialog
informing the user that the extraction process was a success.

4.7.1 Startup Message

The "Startup Message" offers options for the first dialog window displayed, when the self-extracting
archive file is launched. Three different message types are available, as well as the option to display
your own custom message.
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4.7.2 Caption

The "Caption" option allows you to alter the dialog caption of the self-extracting archive.

4.7.3 Command line to Execute after Extraction

The "Command line to Execute after Extraction" allow you run a program and file after the extraction is
complete. 
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4.7.4 Default Extraction Path

Allows you to set the default destination path for the extracted files. 
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5 Command Syntax

Syntax:

PLUGIN RBZIP vResult|<Parameters>

Display the RBZip Window 

SHOW_DIALOG – shows the dialog screen to manipulate zip files

Zip Archive Process

ACTION_ADD – will add files to an existing archive file, and/or creates a new archive

Parameter Value Description

ADD_FILE_NAMES value specifies the file name
(abc.ext or *.* or *.ext)

ADD_ENCRYPT_HEADERS ON
OFF

encrypts file headers for additional security so
that only RBZIP can open the file

ADD_RECURSE_DIRS ON
OFF

includes subdirectories for a specified
directory 

ADD_STORED_DIR_NAMES ON
OFF

keeps the path for files with same name in
different directories 

ADD_STORE_EMPTY_DIRS ON
OFF

specifies to include empty directories

ADD_PART_SIZE OFF
1MB
1,2MB
1,44MB
2,88MB
100MB
650MB
700MB
CUSTOM_SIZE

specifies a disk span size

ADD_CUSTOM_SIZE value specifies a custom disk span size, in kilobytes

ADD_DATE_ATTRIBUTES FILE_DATE
SYS_DATE
MAX_FILE_DATE

specifies file date value

ADD_SHOW_PROGRESS ON
OFF

shows/hides progress window

ADD_COMMENT value adds a comment to zip file

ADD_PASSWORD value adds a password to zip file

Self-Extracting Executable Options

SFX_ASK_CMD_LINE ON
OFF

allows the End User to avoid running the
Command Line option

SFX_ASK_FILES ON
OFF

allows End User to modify the file list to be
extracted 

SFX_AUTORUN ON
OFF

will run an "autorun.inf" file, if exists 

SFX_HIDE_OVERWRITE_BOX ON
OFF

hides the overwrite action group box at
runtime

SFX_NO_SUCCESS_MESSAGE ON
OFF

disables a success message after the
extraction

SFX_OVERWRITE_MODE ALWAYS
CONFIRM
NEVER

specifies the default overwrite action

SFX_CAPTION value specifies the executable window caption
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SFX_COMMAND_LINE value specifies the command line to execute after
extraction

SFX_DEFAULT_DIR value specifies the default directory for the
extraction

Unzip Process

ACTION_EXTRACT – will extract specified files from a zip file

Parameter Value Description

EXT_FILE_NAMES value specifies files for extraction
(*.ext or *.* or filaname.ext)

EXT_FOLDER value specifies the extraction folder

EXT_USE_STORED_DIRS ON
OFF

extracts files with the full path

EXT_RESTORE_FILE_ATTRIBUTES ON
OFF

restores the file attributes

EXT_DATE_ATTRIBUTES FILE_DATE
SYS_DATE
MAX_FILE_DATE

specifies the file date value

EXT_CREATE_STORED_DIRS ON
OFF

creates stored directories 

EXT_RECURSE_DIRS ON
OFF

uses recursion to extract files, which will
extract the files from the archive into the
specified directory, and any sub directories

EXT_OVERWRITE_MODE OVERWRITE
SKIP

skips/overwrites existing files

EXT_SHOW_PROGRESS ON
OFF

shows/hides the progress window

Notes:

· vResult is the text variable to return the status, such as 'OK' or the exact -ERROR- message.

· When listing the zip archive name, the full path must be included.

· When running the PLUGIN command on multiple lines with continuation characters, leave no room
for spaces.

· The first parameter in the RBZip PLUGIN parameters must list the "action" type:

· SHOW_DIALOG
· ACTION_ADD
· ACTION_EXTRACT

· The second parameter must be a zip file name.
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6 Examples

6.1 Example 1

-- the following will display the RBZip dialog window

PLUGIN RBZIP vResult|SHOW_DIALOG

6.2 Example 2

-- the following creates a the Zip1.zip archive file containing all
-- RMD and EEP files. A password is added, with encryption so 
-- only RBZip can open the file. 

PLUGIN RBZIP vResult+
|ACTION_ADD+
|D:\Zip1.zip+
|ADD_FILE_NAMES *.rmd#*.eep+
|ADD_PASSWORD TheKey+
|ADD_ENCRYPT_HEADERS ON+
|ADD_SHOW_PROGRESS ON

6.3 Example 3

-- the following extracts the RMD and EEP files from the 
-- NewFiles.zip archive file, restoring the file attributes,
-- and overwriting any existing files that match the same name.

PLUGIN RBZIP vResult+
|ACTION_EXTRACT+
|D:\DBNEW\NewFiles.ZIP+
|EXT_FILE_NAMES *.RMD#*.EEP+
|EXT_RESTORE_FILE_ATTRIBUTES ON+
|EXT_OVERWRITE_MODE OVERWRITE+
|EXT_SHOW_PROGRESS ON

6.4 Sample Command File

--RBZIP Backup Database Sample

SET MESSAGES OFF
SET ERROR MESSAGES OFF
CLS
CLEAR ALL VAR
IF((CVAL('DATABASE')) = 'RRBYW20') OR (CVAL('DATABASE')) IS NOT NULL THEN
  DISCONNECT
  IF((CVAL('DATABASE')) = 'RRBYW20') OR (CVAL('DATABASE')) IS NOT NULL THEN
    PAUSE 2 USING 'Cannot Disconnect from the database'.
    GOTO LAB_END
  ENDIF
ENDIF

SET TIME FORMAT HH_MM_SS
SET DATE FORMAT MM-DD-YYYY
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SET VAR vFolderName TEXT = NULL
SET VAR vInitFolderName TEXT = (CVAL('CURRDIR'))

SET VAR vParameters TEXT = ('vFolderName|CREATE_FOLDER_ICON ON|TITLE Select Directory
for Backup|PATH_NAME ' + .vInitFolderName)

PLUGIN LoadDirectoryName &vParameters

IF vFolderName = '[Esc]' THEN
  GOTO LAB_END
ENDIF

SET VAR vParameters TEXT = NULL
SET VAR vQuote TEXT = (CVAL('QUOTES'))
SET VAR vDummy TEXT = 'vRBZip'
SET VAR vZipCmd TEXT = 'ACTION_ADD'
SET VAR vParams TEXT = 'ADD_FILE_NAMES
RRBYW20.RX*#*.rff#*.rmd#*.eep#*.dat#*.rba#*.vie'
SET VAR vPipe TEXT = '|'

SET VAR vFileName TEXT = (.vFolderName + ((CTXT((DATETIME(.#DATE,.#TIME)))) + '.zip'))

SET VAR vParameters =
(.vQuote+.vDummy+.vPipe+.vZipCmd+.vPipe+.vFileName+.vPipe+.vParams+.vQuote)

PAUSE 3 USING 'Please Wait...'
PLUGIN RBZIP &vParameters
CLS

IF vRBZip = 'NO_ERRORS' THEN
  SET VAR vMessage TEXT = ('Your database has been succefully zipped.')
ELSE
  SET VAR vMessage TEXT = ('ERROR ' + .vRBZip + ' has occured.')
ENDIF

PAUSE 2 USING .vMessage

LABEL LAB_END

SET TIME FORMAT HH:MM:SS
SET DATE FORMAT MM/DD/YYYY

SET MESSAGES ON
SET ERROR MESSAGES ON

CLEAR ALL VAR

CONNECT RRBYW20

RETURN
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7 Technical Support

Please read over the help documentation at least once before seeking support. We have worked very
hard to make the help documentation clear and useful, but concise. It is suggested that you reread these
instructions once you have become accustomed to using the software, as new uses will become
apparent.

If you have further questions, and cannot find the answers in the documentation, you can obtain
information from the below sources:

· Email our Technical Support Staff at: support@rbase.com
· Access the R:BASE Technologies Support home page online at https://www.rbase.com/support

You may be required to purchase a technical support plan. Several support plans are available to suit the
needs of all users. Available Technical Support Plans

Please be prepared to provide the following:

· The product registration number, which is located on the invoice/order slip for the purchased product
· The type of operating system and hardware in use
· Details regarding your operating environment; such as available memory, disk space, your version

of R:BASE, local area network, special drivers, related database structures, application files, and
other files that are used or accessed by your application

All provide information will be used to better assist you.

R:BASE Technologies has a number of different services available for R:BASE products. As a registered
user, you will receive information about new features for R:BASE and other R:BASE Technologies
products. Please remember to register your software. https://www.rbase.com/register/

mailto:support@rbase.com
https://www.rbase.com/support
https://www.rbase.com/support/plans.php
https://www.rbase.com/register/
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8 Useful Resources

. R:BASE Home Page: https://www.rbase.com

. Up-to-Date R:BASE Updates: https://www.rbaseupdates.com

. Current Product Details and Documentation: https://www.rbase.com/rbg11

. Support Home Page: https://www.rbase.com/support

. Product Registration: https://www.rbase.com/register

. Official R:BASE Facebook Page: https://www.facebook.com/rbase

. Sample Applications: https://www.razzak.com/sampleapplications

. Technical Documents (From the Edge): https://www.razzak.com/fte

. Education and Training: https://www.rbase.com/training

. Product News: https://www.rbase.com/news

. Upcoming Events: https://www.rbase.com/events

. R:BASE Online Help Manual: https://www.rbase.com/support/rsyntax

. Form Properties Documentation: https://www.rbase.com/support/FormProperties.pdf

. R:BASE Beginners Tutorial: https://www.rbase.com/support/rtutorial

. R:BASE Solutions (Vertical Market Applications): https://www.rbase.com/products/rbasesolutions

https://www.rbase.com
https://www.rbaseupdates.com
https://www.rbase.com/rbg11
https://www.rbase.com/support
https://www.rbase.com/register
https://www.facebook.com/rbase
https://www.razzak.com/sampleapplications
https://www.razzak.com/fte
https://www.rbase.com/training
https://www.rbase.com/news
https://www.rbase.com/events
https://www.rbase.com/support/rsyntax
https://www.rbase.com/support/FormProperties.pdf
https://www.rbase.com/support/rtutorial
https://www.rbase.com/products/rbasesolutions
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9 Feedback

Suggestions and Enhancement Requests:

From time to time, everyone comes up with an idea for something they'd like a software product to do
differently. 

If you come across an idea that you think might make a nice enhancement, your input is always
welcome.

Please submit your suggestion and/or enhancement request to the R:BASE Developers' Corner Crew
(R:DCC) and describe what you think might make an ideal enhancement. In R:BASE, the R:DCC Client is
fully integrated to communicate with the R:BASE development team. From the main menu bar, choose
"Help" > "R:DCC Client". If you do not have a login profile, select "New User" to create one.

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the request. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted enhancement request. 

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

Reporting Bugs:

If you experience something you think might be a bug, please report it to the R:BASE Developers'
Corner Crew. In R:BASE, the R:DCC Client is fully integrated to communicate with the R:BASE
development team. From the main menu bar, choose "Help" > "R:DCC Client". If you do not have a login
profile, select "New User" to create one.

You will need to describe: 

· What you did, what happened, and what you expected to happen
· The product version and build 
· Any error message displayed
· The operating system in use 
· Anything else you think might be relevant 

If you have a sample you wish to provide, have the files prepared within a zip archive prior to initiating
the bug report. You will be prompted to upload any attachments during the submission process.

Unless additional information is needed, you will not receive a direct response. You can periodically check
the status of your submitted bug.

If you are experiencing any difficulties with the R:DCC Client, please send an e-mail to rdcc@rbase.com. 

mailto:rdcc@rbase.com
mailto:rdcc@rbase.com
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